
COURSE:  INTRODUCTION TO INFORMATION TECHNOLOGY 

You are welcome to the second part of the course. I am saying this because, as from this 

time onwards, you are going to practice on the computer all that you have been reading 

about in the previous units. For this reason, it is necessary that you go to the nearest 

internet café to practice from time to time in case you don’t have access to one at home.  

 

NOTE: You will produce a soft copy of all the activities on floppy disk and present 

this for appraisal during the residential session. Take a 31/2 Floppy disk along to the 

computer lab during the third section. 

 

Unit three will start you on a sound footing where you will learn the very basics in MS 

Word. I believe it will be a challenge to some of you while others will simply ‘walk 

through’. Whatever situation you may find yourself, don’t let it have any adverse 

influence on your performance. 

 

In your attempt to perform some of the functions we are about to undertake, you may 

come across other interesting features that are not being taken care of in this section. You 

are kindly asked to just jot them down and concentrate on what you are being taught now. 

It is tempting to deviate from the stated objectives when you seem to be more involved in 

the new or strange outcomes of the activities. 

 

 



3.0 UNIT 3 – Preparing a document with Microsoft Word (MS Word) 

 

Introduction 

MS Word is a powerful electronic tool when it comes to word processing and other office 

jobs. It is equally a powerful educational tool when we talk about teaching and learning 

because it gets more work done faster and the teaching process is standardised. It is also 

safe and easy to use. What is more fascinating is that it can be shared through links 

between computers and so can be used for distance learning. You are not being 

introduced to this course because you have to but because you need it to survive in your 

field of study. 

 

Objectives 

The objectives of this unit is to aid you to 

1. Start MS Word 

2. Describe the functions of the menu bar and the toolbars 

3. Use the special keys of the  

4)  

4. Save the document on drives 

5. Open a saved document  

6. Use Spell and Grammar Checks 



3.1. SECTION 1 – Starting Microsoft Word 

Introduction 

I will start you with how to put the computer on and how to manipulate it to your 

advantage. You will be introduced to MS Word interface and to the toolbars and their 

functions. You will also learn to identify the special keys on the keyboard and how to try 

to type and edit what you type.  

 

Objectives 

At the end of this section, you should be able to:  

1. Start a computer  

2. Start Microsoft Word 

 

Starting a computer  

 

 
 to get access to a fully connected Personal Computer’s programmes, you must turn it on 

and this should be done without a disk in the floppy drive. Before you turn the computer 

on, connect the computer to an electrical outlet (these are usually fixed onto the wall). If 

the computer is fixed to an Uninterrupted Power System (UPS), you will have to switch 

that on before putting the Central Processing Unit (CPU) on. But before that, make sure 

all the connections are done properly before you turn on the computer. If in doubt you 

 



may ask the supplier or owner to guide you. (Figure 3.1.1). Note: the UPS stores power 

for a period of time after there is power outage. 

 

The desktop  

When you switch the computer on, it goes through a process referred to as booting. That 

is, checking all its peripherals of faults before opening up the desktop (Figure 3.1.2). 

The desktop is the large coloured area of the screen that has icons for quick access to 

programmes and a Taskbar and this is your working area. Everything you do on your 

computer appears inside frames that are called windows. You can open as many windows 

at one time as you like. You can resize these windows, move them around the desktop, or 

stack them in any order. 

 

 
 

  
Screen shots by courtesy of Microsoft 

Using the mouse 

The mouse controls the cursor or pointer. It has two buttons at the tail end of it. Hold the 

mouse with your right hand (If you are left handed, learn to hold it with your right hand 

as well), your thumb should hold the mouse at its left side whilst the last two fingers hold 

it on the other side. Make the mouse lie flat so that its belly rubs against the mouse pad. 

Move the mouse across the desk. As you do this, remember to keep it flat. Now, your 

fore finger should rest on the button on the left side (called the left button). Whenever I 

want to ask you to click on the left button, I will say LEFT CLICK or CLICK. Your 

middle finger will automatically rest on the button on the right. So if I should say 



RIGHT CLICK, you know what I mean. Now you are going to practice mouse 

movement. 

 

Start Microsoft Word 

A new document is automatically created when you start Word, however you can create 

new one on demand. You can either create a new blank document or one based on a 

template. 

Before we start, I want you to understand the procedure I am going to introduce you to. 

The greater than sign means perform activities in the order that it has been presented. 

Let us try one activity. 

To start MS Word (Figure 3.1.3) 
a) Click on the Start button, located in the Taskbar at the lower left corner of your 

desktop. What happens? 

b) Highlight Programmes in the menu that popped up after clicking on Start.  

c)  

 
c) Left click on Microsoft Word.  

This will be presented in the format shown below:  

To start MS Word:  

 

 

Taskbar >Start >Programmes >Microsoft Word. Good.  



Now let us try this: Menu>File>close. (Let Figure 3.1.4 guide you) What happened? 

Write it down in your notebook. 

 

Start MS Word again and try out the next instruction. 

Menu>File>Exit.  

Note: When you highlight programmes, a lot of those in the computer are displayed. 

Name some programmes in the computer you are using. 

 
Figure 3.1.4 

 

 
Describe Figure 3.1.4. What is peculiar about close in the diagram? See Figure 3.1.5 for 

clue. 
Figure 3.1.5 

 

Now, let us learn how to switch off the computer: Taskbar>Start>Turn off computer 

(the Turn off Computer dialogue box appears, Figure 3.1.6)> Turn off. 



 
Figure 3.1.6 

Summary 

In this section, you have learnt: 

1. how to connect the computer to an external power source and to switch it on and 

off. 

2. how to start Microsoft Word and how to use the interface for processing documents 

 

Activity 

1. Observe how the computer is plugged to an electrical outlet and jot down points. 

2. With your knowledge in starting Word, start Microsoft Excel, Power Point or any 

programme available on your computer. 

3. Exit the programmes and switch off the computer. 



3.2 SECTION 2 – Menus and toolbars in the MS Word programme 

Introduction 

Section 2 talks exclusively about menu bar and toolbars used in Microsoft Word. 

Toolbars, by default, are generally located just below the Menu bar; however this can be 

moved to any part of the interface for your convenience. Before proceeding with the 

lesson, first, make sure that the regular toolbars (i.e. Standard and Formatting) are visible 

on the screen, (Figure 3.2.1).  

       

Objectives 

At the end of this section, you should be able to:  

1. Identify the menu bar and the toolbars 

2. Describe the functions of the menu bar and the toolbars 

3.  

 
3) Use the menu bar and the toolbars in MS Word 

 

 

 



 

 

 

 

 

 

 

MS Word interface  

As soon as you launch (Start) Word, MS Word interface fills the desktop (Figure 3. 2.1) 

Immediately below the ruler is a large area called the work space. This is your working 

area and where you type documents. The blinking vertical line in the upper left corner of 

the text area is the cursor. It marks the insertion point. As you type, your work shows at 

the cursor location, 

 

The Menu Bar   

Whenever you access menu buttons, you give instructions to the software. Directly 

below the Title bar (see title bar below) is the Menu bar. The menu bar has the 

following: File, Edit, View, Insert, Format, Tools, Table, Window, and Help. Direct 

the mouse pointer to any of the menu options and click the mouse to open a drop-down 

menu. To select an option in the drop-down menu click on it. An arrow head after a 

menu item signifies additional options; select that option and a fly-out menu box 

appears. Note: Never try to close the menu bar since it will make it difficult to access 

other toolbars. To access some Toolbars in Word, do the following: 

Menu>View>Toolbars.  

 

Toolbars  

 

 
These are buttons that provide easy access to commands. We can think of the desktop as 

being a working bench and the toolbars as tools that will be used on the bench. Naturally, 



people place tools at convenient places on their work bench to make them work more 

efficiently. So it is with toolbars in MS Word. 

 

Title bar   

The name of the window you access will always appear on the title bar at the top left 

corner. The control icon helps you to manipulate the Window. And in the far right 

corner on the title bar are the minimize button, maximize/restore button and the 

close button. Click on the Minimize  button of the window to shrink it into the 

taskbar (Figure 3.1.2). Click on it on the taskbar to bring it back to its original 

state. Maximize  it to fill the desktop and click on the Restore  button to 

bring it back to its previous position. The Close  button is used to close the 

Window. 

Standard toolbar 
The standard toolbar has short cut icons to specific instructions that you can ask Word to 

perform. Usually when you place the mouse pointer on an icon or button, a yellow box 

with information on it pops out. This is called a tool tip. Direct the mouse pointer to any 

of the icons on the standard toolbar and read what is on the tool tip. Look for the New 

Blank Document and click on it. Note what happened down. What would you do to 

close the Window you just opened? (Get clue on previous page). Click on the Print icon. 

A dialogue box appears on your screen. If a programme needs some information from 

you before it can complete a command, a dialogue box appears. If all the content of a 

window do not fit into the window, simply scroll down the page. How would you close 

this dialogue box? 

 

Formatting toolbar 

The format toolbar helps with icons that help to design your document. You may apply 

format to a text or you may give the command before typing what you want to format. 

With this toolbar, you can choose the font, font style and font size of your document. It 

also helps you to change text to italics, bold, and underline text and helps you to perform 

other functions like highlighting text aligning text and using superscript and subscript 

options etc. Let’s try this. 1. Place the cursor on the work space and type “I am scared”. 



2. Hit the space bar on the keyboard and then click on the bold icon and type “I am bold”. 

Because you have typed something on the work space, when you instruct Word to close 

the document Word will ask you if you would want to save the changes to your 

document. To click ‘No’ implies you don’t want to save that document. If you click ‘Yes’ 

a dialogue box will pop up for you to decide where to save the document and ‘Cancel’ 

will terminate the instruction you gave to Word. 

 

Summary 

In this section you understand that:  

1. after launching Word the window you see is your working area  

2. the toolbars provide easy access and maneuvering of the tools to the user.  

3. you can access the toolbars through the menu bar.  

4. other toolbars provide shortcuts to make work easy when using Microsoft Word. 

 

Activity 

1. Access and name 12 toolbars in Word. 

2. What are the functions of the Toolbars? 



3.3 SECTION 3 – Typing with the computer 

 

Introduction 

Text editing or word processing is one of the most generalized applications of the 

personal computer and MS Word is one of the many software packages that have been 

used. You must use the keyboard effectively to type text or process word. In the first part 

of the course you were introduced to the keyboard. This time, you will try your hands on 

the keys including the alpha numeric keys, special keys and the function keys. You will 

type the words (a letter) below exactly as you see it but you will not make corrections and 

modifications to the letter that you typed even if you make or see a mistake. 

NOTE: Take a 31/2 Floppy disk along to the computer lab. 

 

Objectives 

At the end of this section, you should be able to:  

1. Use the Alpha Numeric keys of the keyboard 

2. Type a letter using Microsoft Word 

3. Save the document on the hard drive 

 

 

 

 

 



 

 

 

 

 

 

 

Using Alpha Numeric keys on the keyboard. 

You will use the Alpha Numeric keys on the keyboard to type the letter below. Don’t 

worry if you are the one-finger typist. We all are. If you haven’t started as yet, then start 

with me. 

Open Word document. As soon as Word window appears on your desktop, the insertion 

point starts blinking. Make sure the Caps Lock key is not activated (Look for the Caps 

Lock key on the keyboard). When this is activated, the Caps Lock Light Emitted Diode 

(LED) at the far right corner of the keyboard will be ON. Press on the Caps Lock key to 

deactivate it. 

 

 To begin typing with an upper case letter, Press the Shift key down before hitting the 

letter. For example the ‘U’ in University of Zapsvilland (Line A) should be typed with 

your fore finger on the Shift key (i.e. Shift + U). To create a space between University 

and of, hit the Space Bar (On keyboard). After typing University of Zapsvilland 

(exactly as it is) hit the Enter key to begin the sentence on a fresh line.  

 

The Numeric keys in a row at the top of the Alpha keys and the three keys between the 

‘M’ key and the right Shift key have two figures on each key tap. The bottom figures are 

typed without holding the Shift key down and the top figures can only be typed when you 

hold the Shift key down. You can activate the Caps Lock key when typing the 

registration number in the formal letter (Line N). Now type the letter the way you see it 

and while you type save intermittently by clicking  



 
on the save icon . This action will always save the changes to your document. 

 

Note: Type the formal letter below exactly as you see it. Make sure you type the letter 

yourself. The office assistant may pop out to ask if you need help in the writing of the 

letter (See figure of office assistant). Click on the radio button with the inscription Just 

type the letter without help to hide the office assistant. Also, ignore the boxes in the left 

margin. They are there for reference sake. 

 

 

Entering and Editing Text 

You will observe when typing the body of the letter (Line M to Q) that Word has a 

special 

Feature that enables text to wrap down to the next line automatically without hitting on 

the 

Enter key. The Enter key is only needed when you want to create a space between 

paragraphs or  

you want to start a new line or paragraph (Lines A to L and R to U). You can always 

insert a text 

or graphic in a blank part of your document by simply clicking in the location and 

entering the text 



or graphic. To enter text, simply type just as you would if you were using a typewriter. O 

enter a  

graphic Click Insert on the Menu bar and select Pictures, then choose which you want. 

 

University part of zapsvilland,  

registrar’s office 

Telephone: +223 (051) 685 712 065/8 ext 211 

Fax: +223 (051) 685 712 069 

Email: uzaps@windstone.com 

Reference: 103UZ – 1a/vol97/9586 

Tuesday, november 12, 2005 

The consular officer 

Quazunboo high commission 

Kumasi 

dear sir, 

Application for quazunboo visa 

Mr. Jeffrey Horn, a level 500Master of Philosophy (Administration) pupil of this 

University, with student registration number MPHIL/AD/2005//001, wishes to visit your 

country during the 2nd semester break in June 2006. He was admitted into the in the 

2004/05 accademic year and will complete his programme in August 2006. He is 

axperted to return to Ghana at the end of the break to continue his programme. A passport 

size photograph of Mr. Horn are inserted below. 

We shall be grateful if you will extend to him any courtesies he deserves. 

Yours faithfully, 

(Kuuku Kofi Djan) 

Fro registrar 

 

Saving the document 

To save document implies retaining the document for further use and for protection 

against power outages. As you are already aware, the computer has a lot of storage drives 

in which you can save your work. You will therefore have to identify where exactly 



you want to save the work so that you can easily retrieve it anytime you want to go 

back to that document. To do this: 

Click Save in File, or click on the Save icon shown on the Standard toolbar.  The 

‘Save As’ dialogue box will be displayed (figure 3.3.1) Click on the arrow head in the 

Save in drop-down 

list. Many options will be made available. Choose where you would like to store the 

document from this Save in drop-down list. In the File name text box, enter the 

appropriate file name which should not exceed 255 characters. It should also not include 

the following symbols \/ ? : ; > < | etc and each file name must be unique within a single 

folder.  

 

For this lesson, let us go by the process listed below. 

 

 

 
 

1 Slot the 31/2 Floppy disk into the floppy disk drive of the computer 

2 Click on the arrow head in the Save in drop-down list. Many options will be 

made available to you.  

3 Choose 31/2 Floppy (A:) If it is a new floppy, the File list box will be empty 



4 Type Visa Application1 in the File name text box. 

5 Hit on the Save button. 

The dialogue box will disappear and Word automatically adds a .doc extension to all 

document file names. You can see the saved document name on the title bar. To save the 

document into another folder with another file name, you can only do that by using the 

Save As option in File.  

 

Summary 

You have learnt in this section that:  

1. MS Word is a word processing package.  

2. the keyboard is used in word processing.  

3. if you are not connected to a UPS, save your work frequently otherwise you may 

lose it.  

4. you can only type certain figures and signs only when you hold down the shift key. 

5. the backspace and delete keys are used to delete graphic and text items. 

6. the enter key is used to start a fresh line or paragraph 

7. Word has a special Feature that enables text to wrap down to the next line 

automatically without hitting on the Enter key. 

8. you can save a document in more than one drive with the same file name. 

 

Activity 

1. Type the letter exactly as you see it 

2.  Save a copy of the typed work in the My Document folder with the file name 

Visa Application2.  

3. Save another copy with the same name in your Floppy disk. 

 

You will be doing a little more of saving and opening documents in the next section. 

Apart from that, you will highlight and insert text into documents and you will use the 

delete keys as well. 

1 



3.4 SECTION 4 – Opening a saved document, adding and editing text 

Introduction 

In section three you learnt about how to save a document. But before then I cautioned 

you to make sure you know exactly where you saved it. In this section you will open that 

same document containing your typed formal letter. You will make corrections using 

delete, backspace keys and use AutoCorrect functions of the computer. You will also 

develop new skills as you go along. 

Note: from this time onwards, take the floppy disk along. Remember that you can destroy 

your floppy disk when the disk is placed in high magnetic environments including mobile 

phones. 

 

Objectives 

At the end of this section, you will be able to:  

1. Open a saved document  

2. Highlight and Insert text 

3. Identify the insert mode 

4. Use delete keys 

 

Opening the saved document  

 



In the last section, you saved the formal letter in two places after you worked on it. 

Because you will be working on that same document, you need to open the document in 

your floppy disk.  

 

 

 

Open the saved document in floppy 

To open the saved document in floppy,  

1 First of all, slot the floppy disk into its drive. 

2 Click on Open in File on the Menu bar. The Open Dialog Box will appear 

(Figure 3.4.1) and all stored documents in My Document folder will appear in 

the file list box. 

3 Because you want to access information in the floppy, click on the arrow 

head in the Look in drop-down list. Many options will be made available to 

you.  

4 Choose 31/2 Floppy (A:) This time, the File list box will have your saved file 

in it. 

5 Click once on it and the file name appears in the File name text box. 



6 Click on the Open button. 

Now that you have successfully opened your document, let us do the following: 

 

Highlighting (Selecting) Text  

To highlight a text means to cause a dark shade of the text. Throughout these lessons you 

will be asked to highlight text. This is because there is the possibility to select a text 

(word) to change its nature either by deleting it or modifying it.  

 

Highlighting by Using the Mouse  

Place the cursor before or after the text you wish to highlight. Hold down the left mouse 

button. Drag the mouse to the left, right, up, or down until the text is highlighted. You 

may also select a word by double clicking on it. To select a sentence, hold down CTRL 

and Click on any part of a sentence. To select a paragraph Triple click on any part of a 

paragraph. To select the whole document click on Select All in Edit on the Menu bar. 

 

Typing and Using the Backspace or Delete Keys  

In case you made a mistake in your typing and you want to make the necessary 

corrections, you can use the Backspace key to delete text to the left side of the blinking 

cursor (insertion point). You can also use the Delete when the cursor is before the text 

you want to delete. Again you can highlight by double clicking on the word you wish to 

delete then press the Delete key.  

 

You can also insert text. To insert text, you must be in the Insert mode. To check to see 

whether you are in the Insert mode, look at the right side of the Status bar, located at the 

very bottom of the screen. If the letters "OVR" are grey, it implies it is inactive and that 

you are in the Insert mode. If the letters "OVR" are black, you are in the Overtype 

mode.  This mode usually frustrates the new user because it keeps deleting as you type. 

Make sure you are not in the Overtype mode. To change into the Insert mode, hit the 

Insert key on the keyboard. 

 

Placing the Cursor  



You will often be asked to place the cursor at a specific location on the document. To 

place the cursor, point to the location specified and press the left mouse button or use the 

arrow keys to move to the specified location.   

 

Summary 

In summary, we have learnt that: 

1. you can highlight by using the mouse or the arrow keys. 

2. if the computer is in the overtype mode it keeps deleting text to the right as you 

type and that to overcome this problem, you will deactivate the OVR symbol on the 

status bar. 

3. when the cursor is to the right of a text you want to delete, hit the backspace tab on 

the keyboard. 

4. when the cursor is to the left of a text you want to delete, hit on the delete tab on 

the keyboard. 

5. you can move the cursor around either with the mouse or the arrow keys on the 

keyboard. 

 

Activity 

1. Save the typed document (you opened) into your floppy with the file name 

Exercise One.  

2. a.) Open a document in My Document folder with the file name Visa 

Application. b.) In the opened document, select the following texts in the letter and 

click on the B button on the Menu bar. 

i. Line H, ii. Line L, iii. Name only (Line T), iv. August (Line P). 

4. Type this sentence in between Lines D and E: Email: qwert@asd.co.zps 

 

In the next section you will learn how to undo, redo text and to correct grammar and 

spellings. 



3.5 SECTION 5 – Editing the document 

Introduction 

This chapter continues with editing text within a document. I will be talking about the 

undo and redo functions. You will also try your hands on correcting spellings and 

grammar and use the AutoComplete function. Don’t forget to take the floppy disk 

along. 

 

Objectives 

At the end of this section, you should be able to:  

1. Use Undo, Redo and Repeat commands 

2. Correct spellings 

3. Correct grammar as you type 

4. Use AutoComplete 

5. Save on the floppy 

 

Using Undo, Redo and Repeat Commands. 

Undo: In case you have done certain changes to your document and you decide to reverse 

the change to the original one, you can use the undo feature of Word. To do this you 

select Edit on the Menu bar and highlight Undo. Or click on the Undo icon in the 

Standard toolbar.  

Redo: If after you have done certain changes to your document but you reversed the 

action but on a second thought you feel the changes should be effected, you can use the 

Redo feature of Word. To do this you select Edit on the Menu bar and highlight Redo. 

Or click on the Redo icon in the menu bar. Repeat: The Edit, Repeat command can be 

used to repeat your last action. 

 

Correcting Mistakes as you Type 

There are certain mistakes that Word does not automatically correct for you. Such words 

are underlined in a red wavy line and those that have grammatical errors in them are seen 

with green underlined wavy lines. 

 



Correcting Spellings:  To correct a spelling error, right click on the words with the wavy 

red line (Figure 3.5.1). Word will suggest options as to how to fix the problem. With the 

options given, all you need to do is to highlight the most appropriate option and click on 

it. This will immediately correct the problem. There are some words particularly names 

of people who have the red wavy line underneath. This tells you that Word does not 

recognize these. Right click on them and select Ignore All. 

Now do the corrections in the formal letter you typed. Let figure 3.5.1 guide you.  

 

 
Figure 3.5.1 

 

 

 



Correcting Grammar as you Type: To correct a grammar error, right click on the 

words with the wavy green line (Figure 3.5.2). Word will suggest options as to how to 

fix the problem. With the options given, all you need to do is to highlight the most 

appropriate option and click on it. This will immediately correct the problem. There is 

one instance of these in the formal letter. Do the correction. 

 

Note: The wavy lines do not print when the print command is given. 

Using AutoComplete 

Word easily recognizes common words and phrases and will offer suggestions for the 

completed form of the word or phrase as you type that word or phrase. You will notice 

this especially when you are typing a date. Word will pop up a yellowish box with the 

correct date within. This is usually shown at the top of the date that you are typing 

(Figure 3.5.3). To accept Word’s offer, simply hit on the ENTER key. Word recognizes 

the name and company names that were registered during installation, and also Auto Text 

entries.  

 

 
 
 

Figure 3.5.3 

 

Summary 

We can summaries what we have learnt in this section as follows: 

1. Word has features that help in correcting spellings and grammar as you type. 

2. Word also comes in handy when it becomes necessary to undo and redo text. 

3. the wavy lines do not print when the print command is given. 



4. Word offers suggestions for the completed form of words or phrases because it 

recognizes words that were registered during installation or during Auto Text entries. 

 

Activity 

1. Correct all spellings and grammar in the formal letter that you typed. 

2. Refer to Appendix 1 and make the modifications learnt in this section. 

3. Save the letter onto the floppy disk with the name Exercise Two 

 

In the next section, you will use the cut, copy and paste functions of Word. You will 

also preview a document to be printed and Print a document. 

 



3.6 SECTION 6 – Using more editing tools 

Introduction 

After completing the sixth section you should be able to perform certain very basic tasks. 

You will learn how to cut, copy and paste in word. These features including drag-and-

drop help you to move text around with ease. After that you will perform the print 

preview option and finally you will print your first document.  

 

Objectives 

At the end of this section, you should be able to:  

1. Cut and Paste text in a document 

2. Copy and Paste text in a document 

3. Use Drag-and-Drop feature 

4. Set up a page for printing 

5. Preview a document to be printed 

6. Print a document 

 

Cut and Paste  

In Microsoft Word, you can cut (delete) text from one area of the document and store that 

text temporally so it can be pasted elsewhere in the document. When you cut text, it is 

stored on the Clipboard. Information stored on the Clipboard stays there until new 

information is either cut or copied. You must highlight the text before you can cut or 

copy a text. It implies that if the text is not highlighted, the cut or copy options in Edit 

will not be activated. When the buttons are not activated, they look grey in appearance 

and there is no effect when you attempt to click on it. 

 

Cut - Using the Menu  

Highlight text>Menu>Edit>Cut 

Paste - Using the Menu  

Identify new location> Menu>Edit>Paste 

Copy and Paste  



In Microsoft Word, you can copy text from one area of the document and place that text 

elsewhere in the document. As with cut data, copied data is stored on the Clipboard.  

Copy - Using the Menu  

To Copy Text, Select the text> Menu>Edit>Copy 

Paste - Using the Menu  

Identify new location> Menu>Edit>Paste 

 

Using Drag-and-Drop 

The Drag-and Drop feature is a faster way to move text around a document but this 

feature is used in situations where you can see the original location of the text and the 

new location where you wish to insert the text on the same screen.  

 

To Move Text Using Drag-and-Drop Feature 

Select the text you want to move, point the cursor to the selected text and hold down the 

left mouse button. When dragging the text to its new location, a dotted insertion point is 

linked to the point of intersection. When you reach the required location, release the 

mouse button that you have been holding on to. 

 

Note: If you hold the Control key down before dragging the item, you will be copying the 

item to its new location rather than moving it from its original spot. 

 

Document View  

With word, you can display your document in one of four views: These views help you to 

get a good view of your work depending on what you are doing. They can be got from 

the view option on the Menu Bar. You can equally get the shortcut from the far left 

corner of the horizontal scroll bar (Figure 3.2.1). These are Normal, Print layout, Online 

Layout, and Web layout views.  

Normal view: Normal view is used typing editing and formatting text. 

Print layout view: In this view text, graphics and other elements are displayed for you to 

see how they will look like on the printed page. 



Outline Layout view. This shows you the structure of your document. Headings and sub 

headings as well as the body of the text are all reflected in the outline view.  

The Web Layout view shows you how the document will look like should it be 

published in the internet or an internal intranet. In some instances it is referred to as 

Online Layout View. 

 

Before moving ahead, check to make sure you are in Print Layout view. If not, go to: 

Menu>View> Print Layout view 

 

To print a document 

To print a document, do the following: 

Click on Print in File on the Menu bar. A dialogue box will appear. In the dialogue box 

choose the printer from the Printer Name drop down list. Select Current page in the 

Page range. If you need only one copy, accept the default and click Print.  

 

Print Preview 

It is important to know how your printed material would look like before printing it. The 

Print Preview function is used to do that. To see the document displayed on the screen 

exactly as it will appear on paper, go to: 

Menu>File>Print Preview. The dialogue box will appear (Figure 3.6.1). 

 

 



 

 

 

 

 

When working within Print Preview, the Print Preview toolbar will be displayed. The 

first icon is the Print button, which helps you to print one copy of the document. The 

second is the Magnifier button which when switched on causes the pointer to change into 

a magnifying glass. You can make changes within the Print Preview by using the Editing 

mode. When the button is switched again, it disables the editing mode. A button showing 

an icon with a single sheet on is the One Page button and clicking on this will display 

one full page on the screen. Another showing four sheets icon can display up to twenty-

four pages at the same time on the screen. To display multiple pages, click on this button 

and drag over the number of pages you wish to display shown on the drop down grid. The 

Zoom Control Box is to help select the required percentage to move to that size or you 

can type the percentage that you prefer. A View Ruler button hides or displays the ruler. 

This, when in view, can be used to resize margins, set tabs and adjust paragraph 

indentations.  

 

Summary 

We can summaries what we have learned in this section as follows: 

1. Word processing is made easy with the introduction of the cut, copy, paste 

and Drag-and-Drop options 

2. features help to move text around with relative ease. 

3. MS Word allows you to view your document in four views with each 

having its own advantage. 



4. MS Word allows you to preview a document to be printed before you print 

it. 

5. MS Word allows you to print documents in a more efficient way. 

 

Activity 

1. Cut student (Line N) and paste it on pupil (Line M). 

2. Copy by dragging University (Line M) to Line O in between the and in. 

3. View your document in Print preview 

4. Print a copy of the work done so far. Keep this for assessment 

5. Save the letter onto the floppy disk with the name Exercise Four 



4.0 UNIT 4 – Formatting a document 

Introduction 

Congratulations for making it to the last stages of the course. I have no doubt in my mind 

that you will finish with flying colours. I hope you are enjoying it too. 

 

This unit looks into new aspects of word processing, the manipulation of text, creating of 

tables insertion of clip arts and pictures as shown in the letter you typed and a little bit of 

drawing that can guide you into a more advanced programme in the ICT world. I hope 

that you forge ahead in this last stage and do a lot of practice in order to meet the 

challenges that confront you as a teacher. 

 

Objectives 

At the end of this unit, you should be able to:  

1. Use a dialogue box 

2. Change type of font, style, size and colour 

3. Use indent, spacing and alignment 

4. Build bullets and numbers 

5. Apply word art to text 

6. Insert a clip art in a document 

7. Place pictures in a document 

8. Work with Tables 

9. Use graphics 

 

 

 

 

 



4.1.1 SECTION 1 -  

Introduction 

Earlier in the course you learnt about Save As and the Open dialogue boxes because you 

had to do some saving of the work you did and you had to open the saved document. You 

will, in this section, use more of the dialogue boxes to execute commands.  

 

Objectives 

At the end of this unit, you should be able to:  

1. Use the dialogue box 

2. Change type of font, style, size and colour 

 

 



 

 

 

 

 

 

 

 

 

Dialogue box 

As discussed, a dialogue box becomes necessary if a programme needs some information 

from you to complete a command. The dialogue box will ask you to identify specific 

operations that will help it perform the action you wish it to execute. You will do that by 

either clicking a button on request, checking a box or a radio knob, typing in information, 

or selecting options in the dialogue box. After which you click on Okay to confirm your 

previous instruction(s). Figure 4.1.1 shows the dialogue box for altering font attributes. 

Click on the Text Effect and see what happens when you select an animation. This is 

mostly used when you wish to add animation to on-line document.  

 

Change Font Features 

You must first highlight the text you want to apply the format to. To change the font 

features, click on Font in Format on the Menu bar. The font dialogue box shown in 

figure 4.1.1 appears on the screen. Click the Font tab to display the font property sheet. 

Chose the options in the categories given in the property sheet and when satisfied with 

your choice, click ok. You can view true shapes in preview box. The options are 

explained below. 

   

Font Size 

Font sizes that are recommended for official and academic documents are between 10 

and 12 points. Points are used to determine the sizes of fonts. For example, 25.4mm font 

height is equivalent to 72 points. A 14 point size font is appropriate for official headings. 



 

Font Name or Style 

The Fonts are unique by their character curves, slants and serifs (tails). Increase the font 

size in the dialogue box so you can see clearly the true shape of the font in the Preview 

box.  Times New Roman or Ariel may be used for official documents. In the above 

figure, I selected Monotype Corsiva. 

 

Font Appearance 

The font attributes such as bold, italics and underline draw emphasis to a particular 

heading or piece of text. As a general rule, it is advisable to use only two different fonts 

and vary the size or apply attributes sparingly. 

 

Summary 

This section explains how MS Word has made it possible to: 

1. use italics, underline and bold options.  

2.  use the dialogue box to collect instructions from you to complete a command. 

3. make modifications on font’s style, size, name and colour. 

 

Activity 

1. Open your saved document. 

2. Iintroduce italics to the registration number (Line N).  

3. Underline and bold Line L. 

4. Underline name only (Line T). 

5. Name the three main properties that determine how a text should look like. 

6. Save your work with Exercise Five as the file name. 

 

In the section to come, you will study the aspect of formatting documents. 

 



4.2 SECTION 2 – Paragraphing the document 

Introduction 

The section deals with the issue of paragraphing and alignment in Word. You will go 

through two instructions that will help you perform these tasks with ease.  

 

Objectives 

At the end of this section, you should be able to:  

1. Use indent and spacing 

2. Use alignment 

 

Indentation  

 

 
Indentation, like the term implies, is causing some dent in the paragraph that has been 

formed. It allows you to create a dent to your paragraph from the left or right margin or 



both. To indent a paragraph, for example the first paragraph of the formal letter (Lines M 

to Q) highlight the paragraph then go to: Paragraph in Format on the Menu bar. A 

dialogue box pops out (Figure 4.2.1). Select 10mm in the left field and 10mm in the right 

field, and then click on Ok.  

Your paragraph should now be indented 10mm from both the left and right margins 

(Figure 4.2.6). 

 

 
 

Alignment  

Microsoft Word gives you a choice of several types of alignment. Text can be aligned to 

the left, right, centred or justified.  

 

Left-align text   

Left-align text is causing the left side to be in a straight order while the right side could 

be dent. It is the default setting. (Figure 4.2.2) 

 

 
 

Figure 4.2.2  

 

Right-align text  

This is where the text is aligned to the right of the document but the left side could be 

dent. Most addresses typed at the right side of the document are right justified. (Figure 

4.2.3) 

 

 



 

Figure 4.2.3 

 

Centred text  

Centred text is centred between the left and right margins. These are mostly used for 

headings and titles. (Figure 4.2.4) 

 

  
 

Figure 4.2.4 

 

Justified 

Justified text is where the text is made to fill the whole space of each line so that both 

sides could be aligned. And it always looks as though some texts are missing. This format 

is not appropriate particularly for academic use. They are mostly seen in the dailies. 

(Figure 4.2.5) 

 
 

Figure 4.2.5 

 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

The following exercise demonstrates how to align text.  

Highlight the paragraph then go to Menu>Format>Paragraph> Indents and Spacing tab> 

Alignment pull-down menu>Left/Right/Centre/Justified>Okay  

The paragraph should now be aligned.  

Highlight the paragraph then go to: Paragraph in Format on the Menu bar. A dialogue 

box pops out (Figure 4.2.1). Select Indents and Spacing tab, and then click on Alignment 

pull-down menu and choose the type of alignment you want, be it 

Left/Right/Centre/Justified. Click Ok to align the paragraph. 



 

Summary 

You realise in this section that: 

1. MS Word has the capability of indenting paragraphs for easy reading. 

2.  MS Word is able to align text in any form to blend with the intended purpose. 

 

Activity 

1. Open the saved document with the file name Visa Application. 

2. Copy the entire formal letter to a new document. 

3. Indent Lines A to F by 50mm in the left field only. 

4. Right align the date in the letter. 

5. Centre the title of the Letter. 

6. Save your work as Exercise Seven in your floppy. 

 

You will now have the opportunity to insert symbols and special characters to your 

document in the next section. Building bullets and numbers in a document enhances the 

appearance of the document and makes it easy to read. You will apply these bullets to 

your work too. 

 

 

 

 



4. 3 SECTION 3 – Using bullets and numbers 

Introduction 

You cannot function properly in word processing if you cannot insert symbols to a text. 

Some types of documents will contain lists of information that can be made clearer and 

easier to read by the addition of bullets. In this section, you will be looking at how to 

insert symbols to a document and you will also study how to apply bullets and numbers 

to the document.  

 

Objectives 

At the end of this section, you should be able to:  

1. Insert symbols and special characters to a document 

2. Apply Build bullets and numbers 

 

Symbols and Special Characters 

You can insert symbols such as (, “, &, % and, @ into your document text by finding 

them on the keyboard. However, there are certain symbols and special characters that are 

not easily obtained on the keyboard. MS Word has made it possible to look for these 

symbols and special characters in a dialogue box situated in Insert on the Menu bar. 

Selecting the Insert, Symbol command greatly makes word processing easy for the user. 

This command can be used to insert symbols and special characters such as ∑, ☻, ♀, 

Җ, ®, ©, — and ™.  
 



 
Nonbreaking spaces are inserted between words such as proper nouns to prevent them 

being split by a line ending. For example, if you want to keep the words Osei Banahene 

together, you would insert a nonbreaking space between the words. Then, if Osei is 

wrapped onto a new line, Banahene goes with it too. 

 

 

 

To Insert Symbols and Special Characters 

1 Move the insertion point to where you would like the symbol/special 

character to appear. 

2 In Menu: Select the Insert, Symbol menu option. The Symbol dialogue box 

will be displayed. 

3 To insert a symbol, click on the Symbols tab and choose the font containing 

the preferred symbol from the Font drop-down list. Select symbol and click 

the Insert button. Or to insert a special character, click on the Special 

Characters tab then choose the character you require and click on Insert to 

insert it into your document. 

 

There are however certain symbols that can be got from shortcuts. For example the 

Ghanaian cedi sign. To Insert the Cedi Symbol, Type the following: Alt + 155. 

 

Using Bullets and Numbering 



Including Bullets and Numbering can make communication simpler and easy to 

understand. The addition of Bullets such as ,  and  or numbers such as 1. 2. 3. to a 

word document can also greatly cause it to be appealing. The Bullets and Numbering 

buttons can be found on the Formatting toolbar. 

 

To Apply Bullets or Numbers Using the Formatting Toolbar 

a) Select the paragraph(s) you want to apply bullets or numbers to  

b) Then click either the Numbering button or the Bullets button on the 

Formatting toolbar.  

c) The bullet symbol or number will now be applied to the selected 

paragraph(s) or text.  

 

NOTE: I have just used bullets and numbers to make the procedures in Inserting 

Symbols and Special Characters and Applying Bullets or Numbers Using the 

Formatting Toolbar (see above) meaningful. 

 

These buttons are toggle buttons, so if you click on them once, the bullets or numbers 

will be switched on. If you click on them again, the bullets or numbers will be switched 

off. A hanging indent will also be applied to the selected paragraphs so that subsequent 

lines will be aligned properly below the first. 

 

1 If you add another paragraph within a bulleted list, a bullet will be added 

automatically.  

2 This will also happen if you press Enter at the end of the last paragraph in the list.  

3 If you add another paragraph within a numbered list, the new paragraph will be 

given the appropriate number for its position within the list and the following 

paragraphs will be renumbered.  

4 If you press Enter at the end of the last paragraph in the list, the next consecutive 

number will be assigned to the new paragraph.  

5 To complete your numbered or bulleted list, press Enter twice. 



6 The Bullet and Numbering buttons on the Formatting toolbar apply the currently 

selected 

bullet symbol and number format to your text.  

7 You can select another bullet symbol or number format for the selected 

paragraph(s) using the Format, Bullets and Numbering menu option. 

 

Note: If you want one or more paragraphs in your list to be excluded from the numbering 

 

 
sequence or to appear without a bullet, you can achieve this by clicking between the 

Number/bullet and the text then pressing Backspace. 

 

Joining Separated Lists 

To join lists, select the first item that should be numbered with the next number in the 

sequence then display the Numbered property sheet in the Bullets and Numbering 

dialogue box then click the Continue on previous list radio button. Click OK to join the 

lists. 

 



Summary 

You have learnt in this section that: 

1. Word has the ability to insert symbols and special characters to a document. 

2. Word helps you to simplify your document by allowing you to apply bullets and 

numbers to the document. 

3. Dialogue boxes are used in all situations and these are made available on the Menu 

bar.  

 

Activity 

1. Type the following below and apply bullets to them 

Theories Underlying Perceived Changes in Teaching and Learning.  Lecturers in the 

Internet Environment.  Innovations and Change on Learning Technology.  Gender, 

Age and the Internet Initiative.  Understanding User Perception.  Considering Human 

Attitude.  Social Cognitive Theory and Self-efficacy.  Technology Acceptance 

Model.  

2. Type these in Figures Six Million, Nine Hundred and Twenty five Thousand 

Cedis. 

3. Why would you use a Nonbreaking space symbol in your document?  

4. Save the activities you just performed onto your floppy with Bullets as the file 

name. 

 

There are more insertions to be done and that is what you will be doing in the next 

section. Get ready for that interesting topic. 

 



4.4 SECTION 4 – Inserting Graphics into a document 

Introduction 

We have been dealing with word processing for some time now and I am sure you are 

now capable in producing word documents. I want us to venture into more advanced 

areas of MS Word where Word Art, Clip Arts, AutoShapes, Printed Water Marks and 

Pictures are introduced to documents. You already know what I am talking about because 

you have appendix 1 to say it all.  

 

Objectives 

At the end of this section, you should be able to:  

1. Insert a Clip Art in a document 

2. Place Picture in a document 

3. Apply Word Art to text 

4. Use AutoShapes in Word document 

5. Introduce Water Mark into a formal letter. 

 

Inserting Graphics 

 

 



Graphics are inserted into documents to add more authenticity and meaning by way of 

illustration to what is being described. The choice of graphics will depend upon what the 

author is trying to demonstrate in his writing. You can insert graphics from different 

locations: Word art, Clip Art, Pictures, A directory on the computer’s hard disk, A floppy 

disk, and External media. e.g. Scanner, Camera, etc. 

 

Note: The clip art is a gallery of pictures, sounds and video clips that you can insert into 

your document. 

Inserting graphics from the clip art gallery  

Inserting graphics from the clip art gallery is an interesting exercise;  

1 Place the cursor at the point where the picture should be placed. 

2 Click on Insert in the Menu bar. 

3 Highlight Picture to display a fly out submenu. 

4 Click on ClipArt. The Insert Clip dialog box is displayed. 

5 Click the Animals category to display the pictures of some animals. 

6 Click on any available animal in your computer to display a context menu. 

7 Click on the Insert button to insert the picture.  

8 Click the Close button  to close the dialog box. 

Let us insert a picture of a man into the letter you have been typing all along. This picture 

will represent our man Mr. Horn. Figure 4.4.2 D 

 



 
 
 

 

 

 

 

 

 

 

Printed  

 

Inserting graphics from the picture gallery  

This procedure applies to all other graphics in use. So in the letter, I picked a picture from 

a camera which was stored in My Documents. This was how I retrieved the picture.  



1 Place the cursor at the point where the picture should be placed. 

2 Click on Insert in the Menu bar. 

3 Highlight Picture to display a fly out submenu. 

4 Click on From File. The Insert Picture dialog box is displayed. 

5 Click the Pictures category to display all pictures in the gallery. 

6 Click on any available picture in your computer to display a context 

menu. 

7 Click on the Insert button to insert the picture.  

8 Click the Close button  to close the dialog box. (Figure 4.4.2.D) 

 

Watermark: PRACTICE THIS AFTER GOING THROUGH SECTION 6. 

Observe the letter and you will see a printed watermark of the university’s emblem. If 

you are able to capture an emblem with a scanner or camera, that will be an advantage. 

Otherwise I am forced to go beyond Word to introduce you to PAINT. Though the 

procedure is a bit involving, just follow the steps specified below and you will see how 

interesting this feature is.  

1 You will draw the emblem in Word document 

1.  (Refer to section 6 – Using auto shapes). 

2 transport it to Paint and save it in Paint;  

1. to produce a Screen Shot of the Emblem drawn, hit the Print Screen 

button on the keyboard 

2. Start Paint (Start>Programmes>Accessories>Paint) 

3. On the Menu toolbar click on Edit and Paste the Emblem. 

3 From there, you will retrieve it from the Printed Watermark dialogue box onto 

the document by this process.  

1. From the Menu bar, click Format. The drop down menu will appear. 

2. Highlight Background to cause a sub menu to fly out. 

3. Click on Printed Watermark, the Printed watermark Dialogue Box will 

appear. 

4. There are three Options (No watermark, Picture watermark, Text 

watermark) select the Picture watermark radio button. 



5. A Scale drop down menu box will be activated, choose 200%. 

6. Click on an activated Select Picture button that will lead you to an Insert 

Picture dialogue box. 

7. Click on your selected choice in the List Item box. 

8. Click on Insert to place the picture at the Insertion point.  

Inserting graphics from the word art gallery  

In placing a word art, place the cursor at the preferred 

location>Menu>Insert>Picture>Word Art. Word Art Dialogue box appears. Select a 

word art style and click Ok. In the Edit Word Art Text Dialogue Box, Type in text and 

click Ok. 

 

Apply word art to text 

In the formal letter that you produced, the text already exists so you will have to Apply 

the word art to the text. This is how you go by it. Highlight the word(s) and on the Menu 

bar click on Insert, move to Picture and select Word Art. In the Word Art Dialogue box, 

select a word art style and click Ok. The Edit Word Art Text Dialogue Box appears. 

Click Ok. Stop and think about the difference in the two methods. (Figure 4.4.2.A). 

 

Summary 

After discussions, you realise that: 

1. MS Word has the ability to manipulate graphics in Word to its best advantage.  

2. these features in MS Word make documents more appealing and interesting to 

work with.  

3. MS Word has the ability to introduce water marks into documents. 

 

Activity 

1. Insert word art, pictures and clip art into the letter exactly as explained. 

2. Save it with the file name grahics1 

3. Name four locations where you can import graphics into Word. 

4. Which graphics have a gallery of pictures, sounds and video clips? 

 



It is now time for tables in Word document. This is what you will be practicing on in the 

next section. 



4.5 SECTION 5 – Creating tables 

Introduction 

The use of Tables and Columns are very important features that you must take up 

seriously since without sufficient knowledge in them they can halt you in your 

presentations. You will learn how to insert tables into a document and to work with 

tables.   

 

Objectives 

At the end of this section, you should be able to:  

1. Insert a table into a document 

2. Working with Tables 

 

Inserting Tables into a Document 

Tables help us to present statistical information in rows and columns. This arrangement 

makes it simple for you to lay out information in a neat, easy-to-read format. You can 

then enhance the appearance of the table to give the look you want by applying any of the 

formatting effects you've learned about so far and/or effects peculiar to tables. The 

intersection of the rows and columns in a table are called cells. It is within these cells that 

the different values or attributes are inserted. Cells can contain both text and graphics.  

 

There are several ways in which you can create a table. You can use 

1 The Table, Insert Table menu option. 

2 The Insert Table button shown on the Standard toolbar. 

3 The Table, Draw Table menu option. 

4 The Draw Table button in Tables and Borders toolbar.  

I will concentrate on the first approach to inserting tables in word. 

 

The Table, Insert Table menu option. 

Go through the followings steps to create a table using the menu bar. Position the 

insertion point where you would like the table to be inserted. Click on Table in the Menu 



bar.  Highlight Insert. Click on Table to display the Insert Table dialog box. In the 

Number of columns textbox, type 3. In the Number of rows textbox type 5. 

 

Click on the AutoFormat button to have access to the Table AutoFormat Dialogue box. 

In the category box choose All Table Styles. Select Table Grid in the Table Styles box. 

The selected table style will be shown in the Preview box. Click Ok to exit the Table 

AutoFormat Dialogue box to return to the Insert Table dialog box. Click Ok to display 

a table with 3 row and 5 columns as shown in Figure 4.5.1 

 

 
Table Gridlines 

As a default, each cell in the table will have a solid black line border. If you remove the 

borders from the cells, grey gridlines are displayed so that you can tell which cell you're 

working in. The gridlines are not printed and you can use the Table>Hide/Show 

Gridlines toggle option to switch their display on and off.  

 

 

Modifying Tables 

You can use the Merge and Split cell function on the Table drop down sub menu to 

modify the table. Simply select the cells that you want to merge or split and click on the 

appropriate button to execute the command. 

 

Working with Tables 



You can move the insertion point around a table by clicking on the cell you want or, 

alternatively, using the TAB key to move to the next cell or SHIFT, TAB to move to the 

previous cell. 

 

Entering Text into the table 

Click the first cell and type Serial No. Press the tab key to move to the next cell and type 

Index No. Continue till all the cells are filled with information to look like this. 



Serial No. Index No. Continuous 

Assessment 

End of Term Total Score 

1 1011000234001 14 45 59 

2 1011000234002 25 43 68 

3 1011000234003 22 38 60 

4 1011000234004 28 39 67 

 

To make the column headings in the first row bold and Centered, Click to the left side of 

the row to select the row. Then go through the process of bolding and centering the text 

as discussed in Unit 4 Section 1. 

After typing in the values, select each column and centre the values. To select a column 

Click the column's top gridline or border (In the process the cursor changes to a black 

downward arrow). 

 

Adding a row to the existing table 

Highlight the contents of the second row (counting from the column headings). To 

highlight a row, Click to the left side of the row. Click Table in the menu bar and 

highlight Insert. Click on Rows Above to insert a new row above the selected row. A new 

row is inserted above the second row as shown in the table below. 

 Serial No. Index No. Continuous 

Assessment 

End of Term Total Score 

     

1 1011000234001 14 45 59 

2 1011000234002 25 43 68 

3 1011000234003 22 38 60 

4 1011000234004 28 39 67 

 

Merge the first and second columns. To do so, highlight the first two rows of only the 

first column. Click on Table in the menu bar and click on Merge Cells. Do the same for 

the second column so that the table will look like that below. 

 



 

Continuous 

Assessment 

End of Term Total Score   

   

1 1011000234001 14 45 59 

2 1011000234002 25 43 68 

3 1011000234003 22 38 60 

4 1011000234004 28 39 67 

 

Fill in the 3rd, 4th and 5th cells with the following values. 40%, 60% and 100%. 

Continuous 

Assessment 

End of Term Total Score   

40% 60% 100% 

1 1011000234001 14 45 59 

2 1011000234002 25 43 68 

3 1011000234003 22 38 60 

4 1011000234004 28 39 67 

 

AutoFit to content 

Highlight the entire table by clicking the Table Move Handle, or drag over the entire 

table. You can also select rows, columns, or the entire table by clicking in the table and 

then using the Select commands on the Table menu, or by using keyboard shortcuts. 

Click Table in the menu bar and highlight AutoFit. Click AutoFit to fit Content. The 

table should like this below. 

Continuous Assessment End of Term Total Score   

40% 60% 100% 

1 1011000234001 14 45 59 

2 1011000234002 25 43 68 

3 1011000234003 22 38 60 

4 1011000234004 28 39 67 



 

 

 

 

 
 

 

 

 

Adding a column to the existing table 

Highlight the contents of the fifth column. Click Table in the menu bar and highlight 

Insert.  

Click on Column to the right to insert a new column to the right of the fifth column.  

A new column is inserted to the right of the fifth column as shown below. 

Continuous Assessment End of Term Total Score    

40% 60% 100%  

1 1011000234001 14 45 59  

2 1011000234002 25 43 68  

3 1011000234003 22 38 60  

4 1011000234004 28 39 67  

 

Type Position in the column heading and rate the students in the table. Your final table 

should look like this below. 

Continuous Assessment End of Term Total Score Position   

40% 60% 100% 4 

1 1011000234001 14 45 59 4th 

2 1011000234002 25 43 68 1st 

3 1011000234003 22 38 60 3rd 

4 1011000234004 28 39 67 2nd 

 



Summary 

In summary, we have learnt that:  

1. you can insert a table into a document and work around in it. 

2. Microsoft has the ability to modify tables with relative ease.  

3. You can cause the content to automatically fit into the cells of the table. 

4. can help you to document the progress of your students or pupils. 

5. you can add or remove cells with ease.   

Activity 

1. Add ten more rows to the table we just discussed and fill it with imaginary 

scores of students. Modify the positions and delete the serial number 

column. 

2. Create the table below. Merge G and B and split R into two columns and 

two rows. Slit T into one column and two rows.  

 

     

 G B  T 

     

  R   

     

     

   

3. Save the tables of the two exercises above on your floppy with the file 

name Tables1. 

4. Which menu option will allow you specify the number of rows and 

columns in a table? 

5. What command(s) on the menu bar can be used to select an entire table? 

6. How would you access the Table AutoFormat Dialogue box? 

7. Name four (4) ways in which you can create a table.  

8. How would you show or hide gridlines? 

 



You are just about to complete the course in introduction to Information Technology and 

for the last section, you will concentrate on using basic shapes features to create and 

colour simple objects.  

 



4. 6 SECTION 6 – Using auto shapes 

Introduction 

Now you will enter into another realm where you will have the opportunity to work with 

auto shapes. In this area, you will manipulate your own diagrams rather than import them 

or collect them from a source as originals. As much as possible, when drawing, try to be 

creative in your designs. You will, however, observe the emblem or University crest in 

the letter and practice your hands on it till you become perfect. Remember I will be 

collecting you floppies as soon as you get to campus. 

 

Objectives 

At the end of this section, you should be able to:  

1. Using basic shapes to create simple objects 

2. Using curve lines to draw shapes 

3. Colour drawn objects 

 

The Emblem 

The emblem was created from the AutoShape gallery. This is not as easy as importing 

pictures or clip arts therefore it needs quite some skill to do a few of them especially with 

the curve line (Figure 4.4.2.C). But before you draw the curve, draw the pentagonal shape 

first (Figure 4.4.2.B).  

 

Creating a simple object (the Pentagon) 

 

 
To draw the pentagon, on the Draw Toolbar, click on AutoShapes and select the 

Pentagon in Block Arrows options. The cursor changes into a Plus. Click this in the 

created space and use this to draw your Pentagon by dragging. When you release the 

mouse button, sizing handles and a 



 rotating knob will be displayed. Place the mouse on the rotating knob (which is green in 

colour) and rotate the object at 90o (Figure 4.6.1) until it looks like that in the letter. 

(Appendix 1).  

 

 

 

 

 

Creating a simple object (the curved down ribbon) 

 

 
The next thing to draw is the Curved Down Ribbon (Figure 4.4.2.E). Draw the Curved 

Down Ribbon From AutoShapes on the Draw toolbar inside Stars and Banners 

option. Insert this into the letter just the same way you inserted the pentagon. 

 

Adding text  

Right click inside the Curved Down Ribbon and click Add Text. Type the inscription 

UZAPS. The Font Name used to type UZAPS in the emblem is the Monotype Corsiva. 

Do you remember this font name? 

 

Drawing the curve 

Follow the procedure listed below to be able to draw the shape. 

 



 
 On the Draw Toolbar, click on AutoShapes and select Curve in Lines option. Use the 

cursor to draw the winding shape. (Figure 4.4.1) 

 
. Click the first point in the blank pentagonal shaped object (or you can draw it elsewhere 

and drag it to its location). The line sticks to the location and when you stretch it, it 

behaves just as a rubber band. When you want to draw a curve, click at the location and 

keep stretching the line. Continue until you draw a similar shape. It may be necessary to 

hit the escape key to stop the action. After that select the object you just drew by clicking 

on it. If the object is selected the sizing handles are visible as in Figure 4.6.2. 

 

Colour drawn objects 

The drawn object here is the curve. To colour this object, follow this steps: Select Object. 

On the Menu bar in Format, click on AutoShape. The Format AutoShape Dialogue Box 

appears. On the Colour and Lines Tab. In the Fill option, select colour Yellow from the 

Colour Drop Down Pallet Box, In the Line option on the property sheet, Select 

Automatic colour and 3/4  point line style. Click Ok. (Figure  



 
4.6.3)  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Summary 

We can summaries what we have learned about using AutoShapes as follows: 

1. AutoShape feature can help you to basic shapes in Word documents 

2.  you can draw simple free form shapes with the curve line feature. 

3. you can colour simple shapes in Word using AutoShapes. 

Activity 

1. Produce a true copy of the letter in Appendix 1 

2. Save it with the file name MS Word Practice on the floppy disk. 

NOTE: Present the floppy for assessment. 

 

CONGRATULATIONS! You have finally come to the end of the reading aspect of the 

course. At least you have gone through without giving up. This is great! You have to 

keep practising till you are perfect. I know that a lot of other features might have cropped 

up during your practise and I will encourage you to jot them all down so you can share 

with your colleagues during the on-campus session. You will recognize that the more you 

study and read wide the more you realise that you have a lot to do. Keep the spirit up and 

visit resource centres and Internet cafes as much as possible.  

 

Glossary 

Appendix  

 


